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Ipswitch Analytics™ is a web-based application for IT professionals that offers a single viewpoint into file 
transfer and processing activity on all of your MOVEit Central and DMZ servers. It is designed to be the 
system of record for all auditable activities that occur across your entire MOVEit system. Ipswitch Analytics 
captures transaction, processing and system data that may be located on MOVEit servers in different 
geographical regions and then presents that data in a web browser for analysis. 

Ipswitch Analytics's interactive Monitor graphs current high-level activity across one or more MOVEit 
servers to verify system status, identify file transfer impacts to business and discover actionable information 
for real-time response to issues. Ipswitch Analytics's customizable Reports show both detailed and 
high-level transfer and processing metrics across one or more MOVEit servers. Run reports on demand, or 
schedule reports for delivery to select business groups on a one-time or recurring basis. Transfer and 
Workflow reports provide a window into the transactions that occur on your MOVEit servers, and help 
identify file transfer impacts to business for planning purposes. User Audit and Security reports help 
administrators track user actions, failed logins and IP lockouts across multiple MOVEit servers and on the 
Ipswitch Analytics Server itself, providing the necessary tools to trace abusive or malicious activity within 
the enterprise.  

Ipswitch Analytics offers end-to-end visibility of critical business processes while providing IT departments 
with the tools they need to collect actionable business intelligence and provide audit trails to meet regulatory 
compliance. The simple-to-use and flexible web interface makes it easy to retrieve key performance metrics 
across multiple MOVEit systems using a single tool. 
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System Requirements 
Analytics Server Requirements (on page 2) 
Analytics Agent Requirements (on page 5) 
Web Browser and Additional Requirements (on page 6) 
 

Analytics Server Requirements 

Ipswitch Analytics Server Requirements 

System size (determined by number of 
Agents. One agent per MOVEit 
server/SQL database) 

Small Medium Large 

# of Analytics Agents  5 or fewer 6-10 11-20 

Minimum RAM 1 4 GB 8 GB 16 GB 

Recommended RAM 2 8 GB 16 GB 32 GB 

Hard disk drive 3 1 TB 2 TB 4 TB 

CPU 4 Core 2.2 GHz  

Network Interface Card Gigabit Ethernet. The Ipswitch Analytics Server machine must 
have network access to the Ipswitch Analytics Agent.  

Windows Server OS 64-bit 2012 R2, 2012, 2008 R2 running on an administrator 
account 

Virtual Machine VMWare ESX 5, Hyper-V 2008, 2012 

1. The amount of RAM required depends on the number of MOVEit servers and their estimated number of 
monthly transactions. The Ipswitch Analytics Server installer tunes the Ipswitch Analytics PostgreSQL 
database automatically based on the RAM detected during installation.  

2. Recommended RAM improves user experience and query performance. 

3. The amount of hard drive space required depends on the number of MOVEit servers and their estimated 
number of monthly transactions. Higher numbers of transactions and/or tasks might require a larger 
hard drive. A transaction includes uploads, downloads, and Central steps. If you are not sure of your 
MOVEit activity level, see Estimating Monthly Transactions (on page 3).  

Recommended: 1 or 2 months after you install the Ipswitch Analytics server, check your system to verify 
that you have enough hard drive space to retain all of your data. 

The Ipswitch Analytics Server must be installed on a dedicated physical or virtual machine. Do not install the 
Ipswitch Analytics Server on a machine that hosts a MOVEit server or a MOVEit database. 
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Estimate Monthly Transactions 
Install the Ipswitch Analytics Server on a machine that has the hardware capacity to properly handle the 
number of transactions that occur on your MOVEit DMZ and Central systems. If you cannot estimate the 
number of monthly transactions, follow the instructions below to calculate 

 The average MOVEit DMZ transactions per month, and  
 The average MOVEit Central transactions per month.  

Add the two together, and then determine whether you have enough hard disk space to retain all of your data 
for 15 months. 

Number of transactions Hard disk size 

<100 K 1TB 

100K to 1 million 2 TB 

>1 million 4 TB 

Note: Complete the steps below for only the type of MOVEit servers on your system.  

MOVEit DMZ:  

1 Select a MOVEit DMZ server that is representative of a typical DMZ server on your system. 

Note: If you think the number of transfers varies widely on different MOVEit DMZ servers in your 
system, perform steps 2-3 for every MOVEit DMZ server. Do not complete step 5; instead, sum the 
average number of transactions from each DMZ server and then divide by the total number of DMZ 
servers. 

2 Sign in as sysadmin and create the following report to estimate that server's average transfers per month: 
 Report Category: File Transfer 
 Report Type: By Month 
 Start/End Date: Select the prior 12 months if available, or as many months as possible within the last 

year. 
3 Find the Total transfers per report time period by calculating the following: (Total number of Uploads x 2) 

+ Total number of Downloads. 
4 Find the Average number of transfers per month for this DMZ server by calculating the following: Total 

transfers per report time period number (calculated in step 3) / Number of months in the report.  
5 Find the Estimated Monthly MOVEit DMZ transactions by calculating the following: Average number of 

transfers per month x Number of MOVEit DMZ servers in your system.  

Note: Logins, logouts, and maintenance actions can be added as a factor when determining impact on the 
system but do not need to be calculated.  
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MOVEit Central: 
1 Select a MOVEit Central server that is representative of a typical Central server on your system. 
2 Select View > Reports. 
3 For Display, select File/Folder Activity.  
4 Click Edit Filter. 
5 On the File/Folder Activity tab, select the following: 
 Status is: Failure and Success 
 Action is: Upload, Download and Process 
 Display any file/folder activity entries with errors, regardless of action 

6 On the Date/Time tab, select Continuous date/time range and select the following: 
 Start Date: Enter a date 12 months prior to today.  
 End Date: Enter today's date. 

7 On the Limit tab, limit results to the 10,000 Newest. 
8 Click OK to run the report. The total number of transactions displays at the bottom right. If the total 

number of transactions shows 10000, select the Large system size. Otherwise, find the average number 
of MOVEit Central transactions by calculating the following: Total number of transactions x Number of 
MOVEit Central servers on your system. 
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Analytics Agent Requirements 

Ipswitch Analytics Agent Requirements 

1 GB of free disk space 

512 MB of free RAM 

Network connectivity with the MOVEit database and the Ipswitch Analytics Server. The Agent machine does not need 
network connectivity with the MOVEit server. 

One or more working MOVEit systems, each with a current license: 
 MOVEit File Transfer Server (DMZ) 8.0 or 8.1 
 MOVEit File Transfer (DMZ) High Availability and Disaster Recovery 8.0 or 8.1 
 MOVEit Central 8.0 or 8.1 
 MOVEit Central Failover 8.0 or 8.1 

Supported MOVEit databases: 
 Microsoft SQL Server 2014 Standard/Enterprise (local or remote) Central 8.1 
 Microsoft SQL Server 2012 Standard/Enterprise (local or remote) 
 Microsoft SQL Server 2008 R2 Standard/Enterprise (local or remote) 
 Microsoft SQL Server 2008 Standard/Enterprise (local or remote) 
 MySQL 5.1.x - 5.5 (local only) 
You can install only one Agent per machine (physical or virtual machine) and one Agent per SQL 
instance. Recommended: Install the Agent on the same machine that hosts the MOVEit database. 

(optional) Virtual machines running on: 
 VMware ESX (32-bit and 64-bit guest servers) 
 Microsoft Hyper-V (32-bit and 64-bit guest servers) 
 Hardware and software requirements for the virtual machine are the same. 

For more information on MOVEit Central and MOVEit DMZ hardware requirements, see: 

MOVEit DMZ Installation Guide 
(http://docs.ipswitch.com/MOVEit/DMZ8.1/manuals/MOVEit%20DMZ%20Installation%20Guide.pdf) 
MOVEit Central Installation Guide (http://www.ipswitch.com/moveit81installation) 
 

http://docs.ipswitch.com/MOVEit/DMZ8.1/manuals/MOVEit%20DMZ%20Installation%20Guide.pdf
http://www.ipswitch.com/moveit81installation
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Web Browser and Additional Requirements 

Supported Web Browsers 

 Chrome: Current and most recent previous release (Windows only)  
 Microsoft Internet Explorer 10 or 11 (Windows only)  
 Microsoft Edge (Windows 10 only) 
 Mozilla Firefox: Current and most recent previous release (Windows, Mac, and RedHat Linux)  
 Safari: Current and most recent previous release (Mac only)  

Additional Requirements 

Adobe Reader is required to read exported PDF reports. 
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How Ipswitch Analytics Works 
Ipswitch Analytics consists of one or more Ipswitch Analytics Agents that pull data periodically from 
MOVEit databases and send that data securely to the Ipswitch Analytics Server. The Ipswitch Analytics 
Server stores the data in a PostgreSQL database and presents it for analysis within a web browser when 
requested.  

An Agent is required for each MOVEit database you want to include in Ipswitch Analytics. For example, if 
you have one MOVEit Central database and two MOVEit DMZ databases, you will need three Agents. 

The standard perpetual base Ipswitch Analytics license supports two Agents connected with a single Server, 
however, a Ipswitch Analytics Server can support up to 20 Agents and up to 100 users may sign in to the 
Ipswitch Analytics Server concurrently. Please visit How to Buy (http://www.ipswitchft.com/how-to-buy) 
to purchase add-on Agent licenses or to convert from an evaluation license to a perpetual license. 

Note: In a MOVEit Central High Availability environment, you install two Agents that use the same license 
but only one Agent is active at a time. See Install Ipswitch Analytics Agents in High Availability 
Enviornments (on page 32). 

The installation package contains a Ipswitch Analytics Server install file and a Ipswitch Analytics Agent 
install file.  

The Ipswitch Analytics Server 
The Ipswitch Analytics Server is a secure web server that uses Apache Tomcat to run as a Windows service. 
The Server receives data from each Agent periodically, consolidates that data into a dedicated PostgreSQL 
database that retains historical MOVEit data, and then presents that data in the form of reports and a 
real-time monitor within a web browser. Up to 100 users may sign in to the Ipswitch Analytics Server 
concurrently. 

Ipswitch Analytics Agents 
An Agent is a Windows service that periodically captures the most recent data from a MOVEit database, 
formats and encrypts that data, and then sends the data to the Ipswitch Analytics Server securely via HTTPS. 
Data collection occurs every one minute for Monitor data and every two minutes for Reports. Agents have a 
small software footprint and use simple read-only queries that have minimal impact on MOVEit processing. 
The Agent's access to the MOVEit database is controlled by credentials entered during Agent installation. 
The Ipswitch Analytics Agent service typically runs on the Agent machine as an administrator user 
specified during installation, or in the context of the standard "LocalService" or "NetworkService" account.  

 
 

http://www.ipswitchft.com/how-to-buy
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Configuration Options 
Before installing Ipswitch Analytics, evaluate your current MOVEit system to determine the best 
installation configuration for your organization. Your organization's MOVEit servers may be located on 
stand-alone machines, separate from their MOVEit databases, or both MOVEit Server and MOVEit 
database may be installed on the same machine. Your organization may have numerous MOVEit servers, or 
perhaps only one or two MOVEit servers.  

Consider the following components when deciding how to install Ipswitch Analytics within your existing 
MOVEit system: 

 The Ipswitch Analytics Server: You must install the Server on a standalone machine. The Server 
installation includes the installation of a dedicated PostgreSQL database. 

 Ipswitch Analytics Agents: You must install one Agent for each MOVEit database that you want to 
include in the Ipswitch Analytics environment for analysis. You can install an Agent on any machine 
that has network access to the MOVEit database; the Agent machine does not need network access to the 
MOVEit server. The Agent must also have network access to the Ipswitch Analytics Server, but cannot 
be installed on the Ipswitch Analytics Server. You can install only one Agent per machine (bare metal or 
virtual machine), and one Agent per SQL instance. 

 MOVEit Central Servers and Databases 
 MOVEit DMZ Servers and Databases 

Below are some sample Ipswitch Analytics installation configurations. Each sample configuration includes 
only one MOVEit Central server and only one MOVEit DMZ server for demonstration purposes. Your 
system could have a different number of MOVEit servers. You can choose a different configuration for each 
MOVEit server if desired.  

Note: The sample configurations show only three web browsers connecting to the Ipswitch Analytics 
Server, but the Ipswitch Analytics Server can support up to 100 concurrent web client users. 
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MOVEit server, MOVEit database and Ipswitch Analytics Agent installed on same machine: 

 
MOVEit server installed on a separate machine, with MOVEit database and Ipswitch Analytics Agent 
installed on the same machine:  
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MOVEit server, MOVEit database and Ipswitch Analytics Agent installed on separate standalone 
machines: 

 
The following four configurations show MOVEit DMZ and MOVEit Central installed on standalone 
machines with both MOVEit SQL Server databases sharing a third standalone machine.  

One Agent installed on the SQL Server database machine and one Agent installed on a standalone 
machine (physical or virtual): 
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Both Agents installed on standalone machines (physical or virtual): 

 

One Agent installed on the SQL Server database machine, the other Agent installed on a MOVEit server: 
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An Agent installed on each MOVEit server: 

 

MOVEIT DMZ WEB FARMS 
If your MOVEit DMZ system is set up as a Web Farm, it contains only one MOVEit database. Install only 
one Agent, either on the Web Farm database machine, or on a separate machine that has a network 
connection connects to the Web Farm database machine. 

MOVEit DMZ Web Farm database connected to multiple MOVEit DMZ servers. Ipswitch Analytics 
Agent installed on same machine as Web Farm database: 
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MOVEit DMZ Web Farm database connected to multiple MOVEit DMZ servers. Ipswitch Analytics 
Agent installed on a separate standalone machine that connects to the Web Farm database: 
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MOVEIT CENTRAL HIGH AVAILABILITY (HA) 
If your MOVEit Central system is set up for High Availability (HA), you will have a primary server and 
a secondary (failover) server that activates only if the primary server fails. Below are the two possible 
configuration options for installing Ipswitch Analytics into a MOVEit Central HA environment. Dotted 
lines indicate dormant connections. 

Single Microsoft SQL Server Database 

MOVEit Central primary and secondary servers point to the same Microsoft SQL Server database on a 
standalone machine. Install one Agent on the MOVEit Central Microsoft SQL Server database machine. 
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Two Local MySQL Databases 

In this scenario, the primary and secondary servers point to their own local MySQL databases. Install 
Agents on each MOVEit Central server. You can use a single Agent license for both the primary and 
secondary Agents since only one database will send data to the Agent at a time.  

 
 

Time Zones 
Ipswitch Analytics Agents may collect data from multiple servers located in different geographic locations. 
When the Ipswitch Analytics Server receives a data record from an Agent, it converts the timestamp of that 
record to GMT (Greenwich Mean Time) before presenting it in a report. All queries also convert user-input 
times to GMT. 
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Security 
The following security methods are in place for Ipswitch Analytics: 

Passwords 
Ipswitch Analytics uses the Advanced Encryption Standard (AES) to protect the passwords used to grant 
access to Ipswitch Analytics, and to protect access to the MOVEit database and the Ipswitch Analytics 
Server.  

 Ipswitch Analytics Agent: The only sensitive data that the Agents store is the password to access the 
MOVEit DMZ/Central database tables and the Ipswitch Analytics Agent password to access the 
Ipswitch Analytics Server. The MOVEit database password is protected using standards-based, 
bi-directional AES256 encryption.  
The MOVEit database password is entered in plaintext during the install process and is encrypted before 
being stored in the configuration. When establishing a connection to the MOVEit database, the 
password is decrypted and passed to the JDBC driver. Internally, the JDBC driver encrypts the password 
using a value supplied by the database server before it is transmitted to the server for authentication. The 
plaintext password is never transmitted or stored. 

 Ipswitch Analytics Server: The Ipswitch Analytics Server stores passwords for locally authenticated 
Ipswitch Analytics users and SMTP server login passwords. These passwords are protected using a 
one-way secure salted hash. When a local user is added to the system, the password that is entered in 
plain text will be hashed and stored in the database.  
When a local user attempts to sign in, the password that is supplied will be hashed and the resulting hash 
will be compared with the stored hash and the user will be authenticated if they are equal. When a local 
user password is changed, the new password must be entered twice. These two passwords are compared 
against each other, and if they are equal, the new password will be hashed and stored in the database.  
System Administrators can also set minimum and maximum password size and a password strength 
policy ranging from Very Tough to Almost None. 

Note: Report data is not considered sensitive and is not encrypted in the database nor on the file system of 
the servers that generate the reporting data or on the Ipswitch Analytics Server.  

All authentication information used by Ipswitch Analytics is encrypted or hashed. Encryption and hashing 
are done using the Java Simplified Encryption library (Jasypt). Details of the Jayspt library can be found at 
www.jayspt.org. For Ipswitch Analytics, hashing is done using the SHA-512 algorithm and utilizes the 
Jasypt library to enhance the protection using random salts and multiple iterations of the hashing function. 
Bi-directional encryption is done using Jasypt to provide password-based encryption. The password is based 
on a random number generated by the Ipswitch Analytics Server at install. 



 

 Introduction 17 

Data Transmission 
Communication between the Ipswitch Analytics Agents and the Ipswitch Analytics Server uses HTTPS, so 
data is always encrypted during transmission. 

Communication between the web client browser and the Ipswitch Analytics Server uses HTTPS, so data is 
always encrypted during transmission. 

Certificates 
Certificates are used for encryption of communications. The Ipswitch Analytics Server supports the use of 
certificates issued by a Certificate Authority and also supports the use of self-signed certificates. 

When the Ipswitch Analytics Server is installed, a keystore is created and the certificates required for secure 
communication between the Ipswitch Analytics Agents and the Ipswitch Analytics Server and also between 
the client browser and the Ipswitch Analytics Server are added to the keystore. 
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Get Help 
Use either of the following ways to get help with Ipswitch Analytics: 

 At the top of the screen, click help and select one of the following: 
User's Guide (for Partners, Monitors, Readers and Creators): Includes instructions for using Ipswitch 
Analytics. 
Administrator Guide (for System Administrators and Administrators). Includes instructions for 
installing, managing and using Ipswitch Analytics.  

 Visit the Ipswitch support website (http://www.ipswitchft.com/support). The main Support page 
contains links to all documentation and help videos, a form to submit a support request, and customer 
support telephone numbers.  

 

http://www.ipswitchft.com/support
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Here is a high-level view of the installation process. Click any item to view instructions for that step.  

Step 1: Gather Items (on page 20) 

 Admin credentials to sign in to your network 
 MOVEit IP addresses or hostnames 
 MOVEit database administrator credentials 
 Certificate Keystore file (optional) 
 Ipswitch Analytics license file 

Step 2: Install the Analytics Server (on page 21) 

 Download the Analytics Server install file 
 Install the Analytics Server 

Step 3: Sign in, Upload the License File (on page 26) 

 In a web browser, navigate to Analytics Server URL 
 Sign in 
 Upload license file to SETTINGS > Licensing 

Step 4: Install Analytics Agents (on page 27) 

 Download the Analytics Agent install file 
 Install one or more Analytics Agents 

Step 5: Verify Agent Functionality (on page 44) 

 Go to the Monitor 
 Verify that all Agents are online 

Step 6: Configure Analytics Server (on page 45) 

 Set global password policy 
 Create user accounts 
 Set up email notifications 
 Create rulesets 
 Create user groups 

INSTALLATION COMPLETE. Give sign in credentials and Ipswitch Analytics Server URL to users. 
 

Install 
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Step 1: Gather Items 
Print this installation worksheet. Before you start the installation, gather the items in the Pre-installation 
Checklist. As you install the product, add your input values to the list. 

 
Next: Step 2: Install the Analytics Server (on page 21) 
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Step 2: Install the Analytics Server 
Install the Ipswitch Analytics Server on a dedicated physical or virtual machine. As part of the installation, a 
PostgreSQL database will be installed on this machine.  

Do not install the Ipswitch Analytics Server on a machine that hosts a MOVEit server or a MOVEit 
database. 

You do not have to stop your MOVEit server(s) to install the Ipswitch Analytics Server.  

High Availability Environments: To install Ipswitch Analytics in a MOVEit Central High Availability 
environment with primary and secondary (failover) databases, first Install the Ipswitch Analytics Server as 
described in this topic, then Install Ipswitch Analytics Agents in High Availability Environments (on page 
32). 

1 Sign in as an Administrator on a Windows Server machine. This will be the account under which all 
Ipswitch Analytics Server processing occurs. 

2 Download the Ipswitch Analytics Server installation file: Ipswitch_Analytics_Base_vn.exe, where n is 
the version number of the software.  

3 Open Ipswitch_Analytics_Base_vn.exe. 

Note: If the machine is missing any prerequisites, a list of software items appears. Click Install.  

The Start Install page of the installer opens. Click Next. 
4 Accept the License Agreement. Click Next. 
5 Select a Destination Folder for the Ipswitch Analytics Server files.     

Caution: Do not specify a destination on a drive that is mapped to a network drive. 

Note: You select the location for the Ipswitch Analytics Server database files in a later step. 
6 Enter the Analytics Server Settings.  
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 System Administrator Username: The username of the user who has access to all of Ipswitch 
Analytics. This user will be the only System Administrator initially.  

 System Administrator Email Address: An email address for the System Administrator. 
 System Administrator Password: The password for the username you entered.  
The installer detects your RAM size automatically to make the determination: 4 GB: Small, 8 
GB: Medium, or 16 GB: Large. 
Click Next. 

7 Enter the Agent Access Settings.     

 
The Agent Access Username and Password are used by all Ipswitch Analytics Agents to authenticate 
with the Ipswitch Analytics Server, and validate data sent from the agent to the server. This account is 
not used by any person. In the Analytics user interface Users module, this username appears in the list of 
users.  
Provide the following information: 
 Agent Access Username: Default name is feeder. Allowed characters: alpha characters a through z, 

numerals 0 through 9, and underscore (_). 
 Agent Access Password: The password for the Agent to use when authenticating with the Ipswitch 

Analytics Server. 

IMPORTANT: Write down the Agent Access username and password on the Installation Worksheet. You 
must provide them when you install an Agent (on page 27). 

Click Next. 
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8 Enter the Tomcat Settings.         

 
 HTTPS Connector Port: The connector port used for HTTPS and the Ipswitch Analytics Server URL.  

Adhere to your IT security or other IT network policies when configuring ports.  
 Ipswitch Analytics Server IP address or hostname: Must match the Common Name (CN) in your 

imported keystore certificate. 
Click Next. The HTTPS Connector Port will be validated. 

9 Specify the Tomcat Logon Account.  
Make a selection based on the account you want to use to sign in and run the Ipswitch Analytics Server 
service: 
 Use Local System Account (default): Uses the Local System account to sign in and run the service. 

This is the account that you used to sign in to Windows. (If you select this option, you are not 
required to provide additional credentials.) 

 Specify a different account: Does not use the Local System account. If you select this option, an 
additional screen opens for you to provide the user name, password, and group of the account to sign 
in and run the Ipswitch Analytics service. To use a domain account, provide credentials in the format 
DOMAIN\username.  

Click Next.  
10 Select a Tomcat Certificate option. 

The Ipswitch Analytics Server uses this information to validate identity certificates.    
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 Create Self-Signed Certificate  

Select this option for Evaluation Accounts only; it creates a certificate that expires in 90 days. 
Provide a password. Click Next. 

 Import Certificate Keystore: Import an SSL password-protected PKCS12 certificate keystore file 
with .PFX or .P12 file extension. Click Browse to locate and select the certificate keystore, and then 
provide the password for the keystore. Click Next. 

11 Select a Database Location for the Ipswitch Analytics Server's PostgreSQL database. MOVEit data 
collected from all Agents is sent to this database. Recommended: Use the default location.  
IMPORTANT: If you select a different database location, it must be a data-specific directory that is not 
limited to a single user.    
Click Next. 

12 Enter the Ipswitch Analytics Database Settings. This information is required to run the PostgreSQL 
database on the Ipswitch Analytics Server. A PostgreSQL database will be installed on this machine as 
part of the Ipswitch Analytics Server installation.        
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 Database Administrator Username: Username for the account that the database administrator can use 

to access the PostgreSQL database if necessary. Recommended: use the suggested username. 
 Database Administrator Password: Password for the Admin Username you specified.   
 Database Access Username: The account that the Ipswitch Analytics Server web application uses to 

access the PostgreSQL database, to insert data that arrives from the Ipswitch Analytics Agents, and 
to retrieve report and monitor data for display. This account is not used by any 
person. Recommended: use the suggested username. 

 Database Access Password: Password for the Access username you specified.  
 Database Port: This port number is predefined to the standard PostgreSQL port. You can specify any 

unused port. 
Click Next. 

13 Review the installation settings, and then click Install. 
14 On the Installshield Wizard Completed screen, copy the URL shown in Next Steps. You need this URL 

to install the Analytics Agent. 
You need a new license file to complete the installation. 

Tip: To open the installer log after installation finishes, select the checkbox. Or you can view the log 
later in the Temp directory 

Click Finish. The Ipswitch Analytics sign in page opens in a browser window. 

Next: Step 3: Sign in and Upload the License File (on page 26) 
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Step 3: Sign in and Upload the License File 
After you click Finish on the Installation Complete screen, the Ipswitch Analytics sign-in page opens in a 
browser window. 

Note: If users will access the Analytics Server from outside the corporate firewall, go to an external 
computer not connected to your network, open a web browser (on page 2), and enter the Analytics Server 
URL in the address bar. If you cannot connect to the Analytics Server from the external computer, you 
might need to configure your firewall to open the port.  

1 Sign in to Ipswitch Analytics using the System Administrator user name and password that you created 
during the Ipswitch Analytics Server installation. The Ipswitch Analytics workspace opens with a 
Welcome message. 
Note: If you cannot sign in, see Troubleshooting (Installation) (on page 60). 

2 Click Browse to License and select your license file.  
The LIcensing page shows: 
 # Licenses: The number of Agent licenses allowed by your license. The base Ipswitch Analytics 

license includes two Agent licenses that can be connected to either MOVEit server type; additional 
licenses are specific to the MOVEit server type.  

 # Available: The number of unused Agent licenses. Initially this number is the same as the number of 
licenses. When you install an Agent, the Agent uses one of the available licenses, and the 
# Available is reduced. 

 The Base Serial Number populates with a long alpha-numeric number. 
The Licenses section lists all available Agent licenses.  

 For more information about: 

 Disconnecting and reconnecting Agents to a MOVEit database, see Licensing 
(https://docs.ipswitch.com/MOVEit/Analytics1.1/Help/Admin/en/index.htm#28525.htm). 

 Purchasing add-on Agent licenses, see How to Buy (http://www.ipswitchft.com/how-to-buy). 

Next: Step 4: Install an Analytics Agent (on page 27) 
 

https://docs.ipswitch.com/MOVEit/Analytics1.1/Help/Admin/en/index.htm#28525.htm
http://www.ipswitchft.com/how-to-buy
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Step 4: Install an Analytics Agent 
For MOVEit Central High Availability Environments (failover): See Install Analytics Agents in High 
Availability Environments (on page 32). 

Install an Agent for each MOVEit database that you want to include in the Ipswitch Analytics environment. 
Install only one Agent per machine.  

Prerequisites 
 The Ipswitch Analytics Server must be installed before you install an agent. 
 The machine that hosts the MOVEit database must be online and network 

accessible.  

Recommended 
configuration 

Install the agent on the machine that hosts the MOVEit database. 

Alternative configurations The agent can be installed on any machine that has network connectivity with the 
MOVEit database. For more information, see Installation Configurations (on page 8). 

Number of Licenses  

Each Ipswitch Analytics agent uses one license. The standard Ipswitch Analytics 
package comes with two agent licenses. 
To add another MOVEit server to the Ipswitch Analytics system at a later time, install 
another Agent and purchase an add-on Agent license. For more information, see  How 
to Buy (http://www.ipswitchft.com/how-to-buy). 

Other information 
It is not necessary to stop the MOVEit server to install an Agent, because the installation 
process does not significantly affect MOVEit DMZ or MOVEit Central system 
performance. 

To install an Analytics Agent: 
1 On the machine where you want to install the Agent, sign in with an account that has administrator 

privileges.  
Recommended: Install the Agent on the machine that hosts the MOVEit database.  

2 Download the appropriate Ipswitch Analytics Agent installation file, where n is the release number: 
 64-bit: Ipswitch_Analytics_Agent64_vn.exe 
 32-bit: Ipswitch_Analytics_Agent32_vn.exe  

3 Open the Ipswitch Analytics Agent installation file. The Welcome page appears. Click Next.  
4 Accept the License Agreement. Click Next.  
5 Select a Destination Folder. Click Next.      

http://www.ipswitchft.com/how-to-buy
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6 Enter the Analytics Server Settings. The Agent forwards data from the MOVEit server to the Ipswitch 
Analytics Server that you specify here.   

 
 Ipswitch Analytics Server IP address or hostname: (From the Tomcat Settings) For example, if you 

entered https://analytics:8443/ura for Ipswitch Analytics Server URL during installation of the 
Ipswitch Analytics Server, enter analytics. 

 Port: The port on which the Ipswitch Analytics Server accepts HTTPS connections. Default is 8443. 
Adhere to your IT security or other IT network policies when configuring ports.  

 Agent Access Username: The username that the Agent uses to authenticate with the Ipswitch 
Analytics server. You specified this username during the Ipswitch Analytics server installation. See 
the Installation Worksheet. 

 Agent Access Password: See the Installation Worksheet. 
7 Click Next.  
8 If the machine on which you are installing the Agent does not contain an installation of MOVEit Central 

or DMZ, select the MOVEit server type for which you are installing this Agent. 

 
Click Next. 
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9 Enter the MOVEit Database Settings.        

 
 Database Type: Select either MySQL or Microsoft SQL Server, depending on the type of database used 

by the MOVEit server you selected in the prior step. 
 Authentication Type (SQL Server only): Select the authentication type that is used for logon to the 

SQL Server.  
Windows: SQL Server logon will use Windows authentication. If you select this option, 
username must be entered in the DOMAIN\User format. 
SQL: SQL Server logon uses a separate user/password created specifically for logon to the SQL 
Server database. 

 Database Name: The name of the MOVEit database. If you are installing the Agent on the same 
machine as the MOVEit server, this field is pre-populated.  

 Hostname or IP Address: The location of the MOVEit database. The value you specify depends on 
your configuration: 

• If the MOVEit database is on the same machine as the MOVEit server, value is localhost. 
• If the MOVEit database and MOVEit server are on separate machines, the value is the Hostname 

or IP address of the machine where the database is located.  

Note: If you are installing the Agent on a machine that contains an SQL Server database with 
multiple instances on the same server, the Hostname or IP Address field prepopulates with the 
default value used by MOVEit Central or DMZ (for example, localhost\instance1). You can 
enter a different instance. If the machine does not contain MOVEit DMZ or Central, you must 
enter the instance name manually. 

• If you are installing the Agent on a machine that does not have MOVEit DMZ or Central, the 
default database name appears here (for example, moveitdmz).   

 Port: The port that is used to connect with the MOVEit database.  Default is the default port value 
for MSSQL/MySQL. 
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Note: If the MOVEit database is using a non-standard port number, you must remove the default 
port number and replace it with the non-standard port number.  

 Username and Password: The username and password that allows access to the MOVEit database.  
For an SQL Server database: The Authentication Type you selected in a previous step determines 
what user credentials you enter here. Windows authentication requires that the username be in 
the DOMAIN\User format. 

Tip: If you cannot locate the username and password to the MOVEit database, look 
in C:\MOVEitDMZ_Install.INI file (DMZ) or C:\MOVEitCentral_Install.INI file (Central). 

10 Click Next. 

Tip: If the connection to the database fails, make sure that your firewall is open. 

11 Enter the Analytics Agent Settings.         

 
 Agent Display Name: Enter a name to identify this MOVEit server within Ipswitch Analytics. The 

name will appear in the Monitor dashboard and in reports.   
Tip: Use the MOVEit Central name in the Agent Display Name so that in the Ipswitch Analytics 
interface, users can identify data that comes from this MOVEit server. 

 Is this a new or existing agent? Select an option: 

• Installing a new agent with a new name: The Agent Display Name must be unique. 

• Installing an agent already known to Analytics Server:  Use this option if an agent with this 
display name was previously installed on this MOVEit Central or MOVEit DMZ server, and 
was later removed.  If you install a new agent on the same server, you can use the same name as 
the "old" agent.  



 

 Install 31 

 Would you like to include historical data? This will import all current data from this MOVEit server: 
• Yes: Ipswitch Analytics includes all historical data from this MOVEit server.  

• No: Ipswitch Analytics reports include data from this time forward only, and does include any 
past data from this MOVEit server.  

Tip: This selection pertains only to the agent you are currently installing and its corresponding 
server. You might want some servers to include historical data but not others. You can select a 
different option when you install other agents. 

Click Next. 

Tip: If the connection to the database fails, check that your firewall is open.  

12 Review the installation setup. To make changes to the setup, click Back. When you are satisfied with the 
setup, click Install. 

Note: If you click Cancel, the installation stops, but the Agent installation folder remains in the 
installation directory you selected. You can safely delete the Analytics Agent directory to remove any 
files that remain after an interruption of the installation process. 

To view the installer log after the installation finishes, select the checkbox. 
To view the log at another time: the log is located in a temp directory in the user's AppData folder. For 
example, C:\Users\Administrator\AppData\Local\Temp\n\MSIstring.log (where n is a number, and string is 
an alphanumeric string). 

13 Click Finish. 
The Ipswitch Analytics Agent service is now running on this machine and immediately starts to report 
data to the Ipswitch Analytics Server. To disconnect this Agent, see Licensing 
(https://docs.ipswitch.com/MOVEit/Analytics1.1/Help/Admin/en/index.htm#28525.htm) in the Ipswitch 
Analytics Administrator's Guide. 

To install another licensed Agent for a different MOVEit database, repeat this procedure (Step 4: Install an 
Analytics Agent).  

About Historical Data 
If during the Agent installation, you chose to include historical data, it might take some time (a few minutes 
to a few hours) to retrieve the historical data and send it to the Ipswitch Analytics server. While the data is 
being captured, the MOVE it server continues to operate, and you can use Ipswitch Analytics. However, 
because data capture is a "trickle" process, some historical data cannot be viewed until the data capture 
process is complete. You are not notified when the Agent finishes including all historical data. To verify that 
the historical data capture process is complete, run a report for a time range in the past. 

Next: Step 5: Verify Agent Functionality (on page 44) 
 

https://docs.ipswitch.com/MOVEit/Analytics1.1/Help/Admin/en/index.htm#28525.htm
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Install Analytics Agents in High Availability Environments 
This topic shows you how to install Ipswitch Analytics Agents in a MOVEit High Availability (HA) 
environment that includes a primary database and a secondary (failover) database.  

Before you install Agents, you must install the Ipswitch Analytics Server (on page 21). 

In a MOVEit Central High Availability environment, you install two Agents that use the same license, but 
only one Agent is active at a time.  

You can install the Agents on the machine that hosts the MOVEit database, or on any machine that has 
network connectivity with the MOVEit database.  

If your MOVEit Central system is set up for High Availability (HA), you will have a primary server and 
a secondary (failover) server that activates only if the primary server fails. Below are the two possible 
configuration options for installing Ipswitch Analytics into a MOVEit Central HA environment. Dotted 
lines indicate dormant connections. 

Single Microsoft SQL Server Database 

MOVEit Central primary and secondary servers point to the same Microsoft SQL Server database on a 
standalone machine. Install one Agent on the MOVEit Central Microsoft SQL Server database machine. 
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Two Local MySQL Databases 

In this scenario, the primary and secondary servers point to their own local MySQL databases. Install 
Agents on each MOVEit Central server. You can use a single Agent license for both the primary and 
secondary Agents since only one database will send data to the Agent at a time.  

 
The machine that hosts the MOVEit database must be online and network accessible before you begin an 
Agent installation. You do not have to stop the MOVEit server to install an Agent. Agent installation will 
not significantly affect MOVEit DMZ and Central system performance. 

First you must install an Agent for the PRIMARY database machine and then install an Agent for the 
SECONDARY database machine: 

Install a Primary Agent (on page 34)  
Install a Secondary Agent (on page 39) 
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Install a Primary Agent 
1 Retrieve the public certificate file for the Ipswitch Analytics Server. You can do this on the Agent 

machine, or on the Ipswitch Analytics Server machine: 
On the Agent machine:  
a) Open a browser to the Ipswitch Analytics Server IP address or hostname and accept the certificate.  
b) Go into your browser's settings to manage certificates and export the public certificate that is 

associated with the Ipswitch Analytics Server. The exported certificate must be in one of the 
following file formats: .pem, .cer, .crt, or .der.  

c) Place the exported certificate on the Agent machine's desktop or easily accessible file location. 
– or – 
On the Ipswitch Analytics Server machine:  
 Copy c:\Program Files\Ipswitch\Analytics Server\apache-tomcat-7\certs\servercert.pem and place it 

on the Agent machine's desktop or other easily accessible location. 
2 On the machine where you want to install the Agent, sign in with an account that has administrator 

privileges.  
Recommended: Install the Agent on the machine that hosts the MOVEit database.  

3 Download the appropriate Ipswitch Analytics Agent installation file, where n is the release number: 
 64-bit: Ipswitch_Analytics_Agent64_vn.exe 
 32-bit: Ipswitch_Analytics_Agent32_vn.exe  

4 Open the Ipswitch Analytics Agent installation file.  Click Next. 
5 Accept the License Agreement. Click Next. 
6 Select a Destination Folder. Click Next. 
7 Enter the Analytics Server Settings. The Agent forwards data from the MOVEit server to the Ipswitch 

Analytics Server that you specify here.       
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 Ipswitch Analytics Server IP address or hostname: (From the Tomcat Settings) For example, if you 
entered https://analytics:8443/ura for Ipswitch Analytics Server URL during installation of the 
Ipswitch Analytics Server, enter analytics. 

 Port: The port on which the Ipswitch Analytics Server accepts HTTPS connections. Default is 8443. 
Adhere to your IT security or other IT network policies when configuring ports.  

 Agent Access Username: The username that the Agent uses to authenticate with the Ipswitch 
Analytics server. You specified this username during the Ipswitch Analytics server installation. See 
the Installation Worksheet. 

 Agent Access Password: See the Installation Worksheet. 
Click Next. 

8 Enter the Analytics Agent Truststore Settings:     

 
 Analytics Server public certificate file: Browse to select the public certificate file that you located in 

the first step of the Agent installation. It has the extension .pem, .cer, .crt, or .der. 

IMPORTANT: Do not use the .p12 or .pfx certificate file that you used during installation of the 
Ipswitch Analytics Server. 

 Truststore password: Enter the truststore password for the certificate. Write down this password and 
keep it safe. You need it when you install an Agent for the secondary failover HA database (on 
page 39), and if you ever have to modify the Agent installation (on page 66). 

The installer creates the ‘ipswitchcerts’ truststore in /jre/lib/security.   
Click Next. 
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9 If the machine on which you are installing the Agent does not contain an installation of MOVEit Central 
or DMZ, select the MOVEit server type for which you are installing this Agent. 

 
Click Next. 

10 Enter the MOVEit Database Settings.    

 
 Database Type: Select either MySQL or Microsoft SQL Server, depending on the type of database used 

by the MOVEit server you selected in the prior step. 
 Authentication Type (SQL Server only): Select the authentication type that is used for logon to the 

SQL Server.  
Windows: SQL Server logon will use Windows authentication. If you select this option, 
username must be entered in the DOMAIN\User format. 

• SQL: SQL Server logon uses a separate user/password created specifically for logon to the SQL 
Server database. 

 Database Name: The name of the MOVEit primary database.  
 Hostname or IP Address: The location of the MOVEit primary database. The value you specify 

depends on your configuration: 
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• If the primary MOVEit database is on the same machine as the MOVEit server, value 
is localhost. 

• If the primary MOVEit database and MOVEit server are on separate machines, the value is the 
Hostname or IP address of the machine where the database is located. 

Note: If you are installing the Agent on a machine that contains an SQL Server database with 
multiple instances on the same server, the Hostname or IP Address field prepopulates with the 
default value used by MOVEit Central or DMZ (for example, localhost\instance1). You can 
enter a different instance. If the machine does not contain MOVEit DMZ or Central, you must 
enter the instance name manually. 

• If you are installing the Agent on a machine that does not have MOVEit DMZ or MOVEit 
Central, the default database name appears here (for example, moveitdmz). 

 Port: The port that is used to connect with the MOVEit primary database.  Default is the default port 
value for MSSQL/MySQL. 

Note: If the MOVEit primary database is using a non-standard port number, you must remove the 
default port number and replace it with the non-standard port number.  

 Username and Password: The username and password that allow access to the MOVEit primary 
database. 

Tip: If you cannot locate the username and password to the MOVEit database, look 
in c:\MOVEitCentral_Install.INI file. 

Click Next. 

Tip: If the connection to the database fails, make sure that your firewall is open. 

11  Enter the Analytics Agent Settings.      

 
 Agent Display Name: Enter a name to identify this MOVEit server within Ipswitch Analytics. The 

name will appear in the Monitor dashboard and in reports.   
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Tip: Use the MOVEit Central name in the Agent Display Name so that in the Ipswitch Analytics 
interface, users can identify data that comes from this MOVEit server. 

 Is this a new or existing agent? Select an option: 

• Installing a new agent with a new name: The Agent Display Name must be unique. 

• Installing an agent already known to Analytics Server:  Use this option if an agent with this 
display name was previously installed on this MOVEit Central or MOVEit DMZ server, and 
was later removed.  If you install a new agent on the same server, you can use the same name as 
the "old" agent.  

 Would you like to include historical data? This will import all current data from this MOVEit server: 
• Yes: Ipswitch Analytics includes all historical data from this MOVEit server.  

• No: Ipswitch Analytics reports include data from this time forward only, and does include any 
past data from this MOVEit server.  

Click Next. 
12 Review the installation setup. To make changes to the setup, click Back. When you are satisfied with the 

setup, click Install. 

Note: If you click Cancel, the installation stops, but the Agent installation folder remains in the 
installation directory you selected. You can safely delete the Analytics Agent directory to remove any 
files that remain after an interruption of the installation process. 

To view the installer log after the installation finishes, select the checkbox. 
To view the log at another time: the log is located in a temp directory in the user's AppData folder. For 
example, C:\Users\Administrator\AppData\Local\Temp\n\MSIstring.log (where n is a number, and string is 
an alphanumeric string). 

13 Click Finish. 

Installation of the primary Agent is complete. The Ipswitch Analytics Agent service is now running on this 
machine and immediately starts to report data to the Ipswitch Analytics Server. To disconnect this Agent, 
see Licensing in the Ipswitch Analytics Administrator's Guide. 

Next, Install a Secondary Agent (on page 39) 
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Install a Secondary Agent 
Important: Before you install a secondary agent, you must Install an Agent for the Primary HA Database 
(on page 34). 

1 On the machine where you want to install the SECONDARY Agent. sign in with an account that has 
administrator privileges.  
Recommended: Install the Agent on the machine that hosts the MOVEit database. 

2 Copy the public certificate file for the Analytics Server from the primary Agent machine to the secondary 
Agent machine. Place it on the secondary Agent machine's desktop or other easily accessible location. 
You located this file in Step 1 of Install a Primary Agent (on page 34).  

3 Open the appropriate Ipswitch Analytics Agent installation file: 
 64-bit: Ipswitch_Analytics_Agent64_v1.exe 
 32-bit: Ipswitch_Analytics_Agent32_v1.exe  
Click Next. 

4 Accept the License Agreement. Click Next. 
5 Select a Destination Folder. Click Next. 
6 Enter the Analytics Server Settings. The Agent forwards data from the MOVEit secondary database to 

the Ipswitch Analytics Server that you specify here.       

 
 Ipswitch Analytics Server IP address or hostname: (From the Tomcat Settings) For example, if you 

entered https://analytics:8443/ura for Ipswitch Analytics Server URL during installation of the 
Ipswitch Analytics Server, enter analytics. 

 Port: The port on which the Ipswitch Analytics Server accepts HTTPS connections. Default is 8443. 
Adhere to your IT security or other IT network policies when configuring ports.  

 Agent Access Username: The username that the Agent uses to authenticate with the Ipswitch 
Analytics server. You specified this username during the Ipswitch Analytics server installation. See 
the Installation Worksheet. 
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 Agent Access Password: See the Installation Worksheet. 
Click Next. 

7 Enter the Analytics Agent Truststore Settings:     

 
 Analytics Server public certificate file: Browse to select the public certificate file that you located at 

the beginning of the Agent installation. It will have the extension .pem, .cer, .crt, or .der. 

IMPORTANT: Do not use the .p12 or .pfx certificate file that you used during installation of the Ipswitch 
Analytics Server. 

 Truststore password: Enter the same truststore password you entered for the Primary Agent 
installation. 

The installer creates the ‘ipswitchcerts’ truststore in /jre/lib/security.   
Click Next. 

8 If the machine on which you are installing the Agent does not contain an installation of MOVEit Central 
or DMZ, select MOVEit Central from the drop-down menu: 

 
Click Next. 
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9 Enter the MOVEit Database Settings.     

 
 Database Type: Select either MySQL or Microsoft SQL Server, depending on the type of database used 

by the MOVEit server you selected in the prior step. 
 Authentication Type (SQL Server only): Select the authentication type that is used for logon to the 

SQL Server.  
Windows: SQL Server logon will use Windows authentication. If you select this option, 
username must be entered in the DOMAIN\User format. 
SQL: SQL Server logon uses a separate user/password created specifically for logon to the SQL 
Server database. 

 Database Name: The name of the secondary MOVEit database. If you are installing the Agent on the 
same machine as the MOVEit server, this field is pre-populated. 

 Hostname or IP Address: The location of the secondary MOVEit database. 

• f the secondary MOVEit database is on the same machine as the MOVEit server, value 
is localhost. 

• If the secondary MOVEit database and MOVEit server are on separate machines, the value is the 
Hostname or IP address of the machine where the database is located. 

Note: If you are installing the Agent on a machine that contains an SQL Server database with 
multiple instances on the same server, the Hostname or IP Address field prepopulates with the 
default value used by MOVEit Central or DMZ (for example, localhost\instance1). You can 
enter a different instance. If the machine does not contain MOVEit DMZ or Central, you must 
enter the instance name manually. 

• If you are installing the Agent on a machine that does not have MOVEit DMZ or MOVEit 
Central, the default database name appears here (for example, moveitdmz). 

 Port: The port that is used to connect with the secondary MOVEit database.  Default is the default 
port value for MSSQL/MySQL. 
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Note: If the MOVEit primary database is using a non-standard port number, you must remove the 
default port number and replace it with the non-standard port number.  

 Username and Password: The username and password that allow access to the MOVEit primary 
database. 
If the secondary database is an SQL Server database, the selection you made in the Authentication 
Type field determines what user credentials you enter here. Windows authentication requires that 
the username be in the DOMAIN\User format. 

Tip: If you canot locate the username and password to the MOVEit database, look 
in c:/MOVEitCentral_Install.INI file (Central). 

Click Next. 

Tip: If the connection to the database fails, make sure that your firewall is open. 

10 Enter the Analytics Agent Settings. 29416 new:29863     

 
 Primary Agent Name: Enter the primary Agent's Agent Display Name. You entered this value in the 

final step of the PRIMARY Agent's installation. 
 Is this a new or existing agent?: This item is disabled. 
 Would you like to include historical data? Select Start with current data.  
Click Next. 

11 Review the installation setup. To make changes to the setup, click Back. When you are satisfied with the 
setup, click Install. 

Note: If you click Cancel, the installation stops, but the Agent installation folder remains in the 
installation directory you selected. You can safely delete the Analytics Agent directory to remove any 
files that remain after an interruption of the installation process. 

To view the installer log after the installation finishes, select the checkbox. 
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To view the log at another time: the log is located in a temp directory in the user's AppData folder. For 
example, C:\Users\Administrator\AppData\Local\Temp\n\MSIstring.log (where n is a number, and string is 
an alphanumeric string). 

12 Click Finish. 

Installation of the secondary Agent is complete. The secondary Ipswitch Analytics Agent service is now 
running on this machine but reports data to the Ipswitch Analytics Server only if the primary database fails. 
This secondary Agent does not display in Settings > Licensing unless the primary database fails.  

About Historical Data 
If during the Agent installation, you chose to include historical data, it might take some time (a few minutes 
to a few hours) to retrieve the historical data and send it to the Ipswitch Analytics server. While the data is 
being captured, the MOVE it server continues to operate, and you can use Ipswitch Analytics. However, 
because data capture is a "trickle" process, some historical data cannot be viewed until the data capture 
process is complete. You are not notified when the Agent finishes including all historical data. To verify that 
the historical data capture process is complete, run a report for a time range in the past. 

Next: Step 5: Verify Agent Functionality (on page 44) 
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Step 5: Verify Agent Functionality 
1 In the web browser where you signed in earlier, navigate to the Monitor module. 

The top of the workspace contains a Dashboard that shows all of the Agents that you installed. 

2 Verify that all Agents are Online  and sending data to the Ipswitch Analytics Server.  If the status 

of any Agent is Unknown  or Offline , see Troubleshooting (on page 60). 
For example, the figure shows three installed agents that are online and sending data to the Ipswitch 
Analytics Server.  

 
To release an Agent license to use with a different MOVEit server, see the Ipswitch Analytics 
Administrator's Guide > Manage > Licensing. 

Next: Step 6: Configure the Analytics Server (on page 45) 
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Step 6: Configure the Ipswitch Analytics Server 
Complete each of the following steps to configure the Analytics Server for the first time.  

1 Set the Global Password Policy (on page 45). 
2 Add user accounts (on page 46). 
3 If you plan to allow scheduled report delivery to email addresses, Set Up Email Notifications (on page 

49). 
4 Optionally Create a Ruleset (on page 51) to: 

• Block Creators from viewing and selecting specific MOVEit servers, organizations and 
usernames in the Templates Filter. 

• Limit a scheduled report to include only specific MOVEit servers, organizations and usernames. 
5 Optionally Create a User Group (on page 57) to: 

• Allow only a specific group of users to view and/or manage a Library report 

• Deliver a scheduled report to a specific group of users 
 

Set the Global Password Policy 
The default password policy requires that all Ipswitch Analytics user passwords: 

 Be a minimum of eight characters 
 Be a maximum of 20 characters 
 Follow the Sturdy password policy: a password cannot be the username or a shorter version of it, cannot 

contain dictionary words, and must contain at least one numeric and one non-numeric character 

To keep this policy, proceed to the next step: Add User Accounts. To select a stronger or weaker password 
policy, follow the steps below. 

1 Go to the Analytics Server URL and sign in as System Administrator 
2 Go to the SETTINGS module and select the System tab.  
3 Select Password Policy. 
4 Select a password policy from the list of built-in user password policies, with strengths from low to 

high: 
 Very Tough: Password cannot contain or be a short version of the username and cannot contain 

popular dictionary words. Password must contain at least one numeric character, one non-numeric 
character, one special character (such as $ or !), and contain uppercase and lowercase letters. 

 Tough: Password cannot contain or be a short version of the username and cannot contain popular 
dictionary words. Password must contain at least one numeric and one non-numeric character, and 
contain both uppercase and lowercase letters. 
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 Sturdy (Default): Password cannot contain or be a short version of the username and cannot contain 
popular dictionary words. Password must contain at least one numeric and one non-numeric 
character. 

 Minimal: Password cannot contain or be short version of the username. Password must contain at 
least one numeric and one non-numeric character. 

 Weak: Password cannot contain or be short version of the username. 
 Almost None: Password cannot be the same as username. 

5 For User password minimum size, enter the minimum number of characters the password must be.  
6 For User password maximum size, enter the maximum number of characters the password can be. 

For more information on user password security measures in place with Ipswitch Analytics, see Security 
(on page 16). 

Next: Add User Accounts (on page 46) 

 
 

 

Add User Accounts 
Access to Ipswitch Analytics requires a user account. Ipswitch Analytics user accounts are not connected to 
MOVEit user accounts.  

Note: The same user can sign in to Ipswitch Analytics at multiple locations. Users can also share the same 
email address. 

1 Open the USERS module. 
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Note: The feeder username is used only for Agent access to the Ipswitch Analytics Server. It has the role 
of Ipswitch Analytics Agent and no name or email is associated with it. If you entered a different name 
for the Agent Access Username during Agent installation, it will show a different name. If you change 
the Agent Access Username or password here, you must modify the Agent (on page 66) and change it 
there also. 

2 Click Add User. The New user page appears: 
3 Provide the following information: 

Username: A unique alphanumeric username. Names are case-sensitive. Duplicate names are not 
allowed, but you can reuse the name of a user who has been deleted.. 
Role drop-down list: The user's Role controls access to Ipswitch Analytics modules and Ipswitch 
Analytics report types, and allows the following actions: 

• Partner: View Transfer and Workflow reports in the Library. 

• Monitor: View the Monitor. 

• Reader: View the Monitor; view Transfer and Workflow reports in the Library. 

• Creator: View the Monitor; view Transfer and Workflow reports in the Library; create reports in 
the Templates and Schedule tabs. This role is for users whose main purpose is to create reports. 
Note: A ruleset can limit the MOVEit sources that a Creator can access when creating and 
running templates, and when creating schedules. 

• Administrator: Access all Ipswitch Analytics modules except the SETTINGS > System tab; view 
all report types, including User Audit and Security reports; create rulesets, assign rulesets to 
schedules. 

• System Administrator: Full access: manage all system settings and access all areas of Ipswitch 
Analytics. 
Caution: Assign users to the System Administrator role with caution. Only System 
Administrators can manage system-wide settings in the Settings module, and can access all 
areas of Ipswitch Analytics. 

The table shows each role, its permissions, and the accessible Ipswitch Analytics modules. 

 
Follow your organization's accepted security practices when assigning roles. 

Password: The field shows a suggested password. Do one of the following: 
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• Keep the suggested password (no action required). 

• To have the system suggest a different password, click Generate. A new randomly-generated 
password appears in the Password box 

• To create a custom password, click Change. The Enter Password for <username> dialog box 
opens. Type the password for the user and click Save.  

Firstname and Lastname: These fields are optional. 
Email address: The address where the user will receive email notifications when scheduled reports are 
ready for viewing.  

The email address does not need to be unique; multiple users can share the same email address for 
the purpose of receiving reports. 

4 Click Save. 
The user is created and assigned the preferred system language.  
Users can change their preferred language after they sign in. Or you can edit the user to change the user's 
language.  

5 Give the following information to users so they can sign in to Ipswitch Analytics: 
 Ipswitch Analytics Server IP address or hostname 
 Username 
 Password 

Next: Set Up Email Notifications (on page 49) 
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Set up Email Notifications 
If you want users to receive email notification when a scheduled report is ready for viewing, you must 
configure email notifications first.  

1 Go to the SETTINGS module and select the System tab. 
2 Select the Enable Email Notifications checkbox.  

 
3 Enter the following information: 
 Host Name: Host name or IP address of the SMTP server. This is the server that will deliver the 

outgoing email messages. For example: smtptest.ipswitch.com or 192.168.1.1. 
 Port: 25 is the default.  
 Enable Authentication: This box must be checked to allow email notifications.  
 Username and Password: The login credentials for the SMTP server. 
 Enable STARTTLS: STARTTLS is a popular protocol used to communicate with the SMTP server. 

Most modern SMTP servers support it because it can use the same port for encryption. If set, and a 
socket factory hasn't been specified, this enables the use of a MailSSLSocketFactory. When Enable 
STARTTLS is checked, enter values for the following: 

• Hosts to trust for SSL connection: Enter the host name or IP address of the hosts you want to 
trust. Wildcards are accepted ("*" will trust all hosts). Enter multiple hosts separated by spaces. 

• Socket connection timeout in milliseconds: 10,000 is the default timeout, but you may want to set 
this higher if you have a slow network. 

• Socket I/O timeout in milliseconds: 30,000 is the default timeout, but you may want to set this 
higher if you have a slow network. 

 Enable HTML email (optional): Sends email notifications in HTML format. If unchecked, email will 
be sent in plain text only.  

 From email address: Enter an email address from which notifications will be sent. 
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Note: Supported email clients are: Gmail, Microsoft Outlook and Apple Mail. 

4 Click Save. 
You can also click Reset to return to the original default Notifications settings. 

Note: If the Save button is not enabled, make sure you've completed all items in the prior step. 

EMAIL SAMPLES: 

HTML email: 

 
Plain text email: 

 
Next: Create a Ruleset (on page 51) 
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Create a Ruleset 
Your system might contain one or more MOVEit servers. Each MOVEit server contains one or more 
organizations, and each organization contains multiple users. These are your MOVEit data sources. 

When users create a new template or edit an existing template in the Template Editor, a Filter displays all of 
your MOVEit sources by default. Users can include all MOVEit sources in a template, or select specific 
MOVEit sources to include, and even save their Filter selections as a custom template. If that template is 
then used as the basis for a scheduled report, the scheduled report will exclude any MOVEit data sources not 
allowed by that template's Filter.  

To further restrict access to your MOVEit sources, you can create a ruleset that allows access to only 
specific MOVEit sources. After you create a ruleset, you can assign the ruleset to a:  

 User Group: When working in the Template Editor, Creator members of the group will be blocked from 
viewing and selecting any MOVEit source not allowed by the ruleset. The Template Editor's Filter will 
display only the allowed MOVEit sources for selection. 

 Schedule: Only Administrators and System Administrators can assign a ruleset to a schedule to provide 
an additional layer of MOVEit source control over scheduled report results.  

When both a filter and a ruleset are in place (for example, if the template used to create a schedule has 
specific Filter settings AND a ruleset is assigned to the schedule), they combine to include only the MOVEit 
sources allowed by both filter and ruleset. 

Rulesets do not affect anything in the Monitor or any report that already resides in the Reports Library. 

You must create a ruleset before you can assign it to a user group or schedule. Only Administrators and 
System Administrators can create rulesets in the SETTINGS module.  

 To create a ruleset: 
1 Open the Settings module.  
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The Rulesets tab opens. No rulesets are listed initially, however, after you create rulesets they will 
display in this window. You'll see each ruleset's Name, Description, the last user to update it (Updated 
by), and when it was last Updated. You can also select and delete a ruleset rom this window. 

2 Click Create. 
The New ruleset window displays. 

 
All available MOVEit sources display on the left, and the Ruleset name and Description display on the 
right.  

3 Enter a Ruleset Name and an optional Description on the right. 
4 On the left, select a Filter that will limit data to only the MOVEit sources you select. 

The Filter drop-down menu lets you select the type of MOVEit source you want to 
view: Servers, Organizations or Usernames. The source list below updates to reflect your selection.  
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For example, if you select Filter Usernames, the source list displays all usernames from All 
Organization(s) across your MOVEit system. The total count of items in the source list displays next to 
the selected MOVEit source type. In the example below, 18 usernames display in the list.   

 
Note: Servers is the default MOVEit source type initially. All MOVEit servers to which you have access 
display in the list of Servers below.  

Use the Search box to locate a specific server, organization or username in the source list when it 
contains a large number of items (the asterisk wildcard is accepted). Enter any portion of the name to 
view all results that contain that string. 
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To display only usernames from specific organizations, click All Organization(s), select the 
organizations to include and click Ok.  

 
In this example, notice that only two organizations are selected. The source list of usernames now 
contains only 13 items from 2 Organization(s). 

 
Similarly, if you selected Organizations for the Filter type, the source list will display all organizations 
from All Server(s) across your MOVEit system. To display only organizations that belong to specific 
servers, click All Server(s), select the servers to include and click Ok.  
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Remember, MOVEit sources are nested: a server contains organizations that contain usernames: 

 
You can filter only one level above the current filter type. You cannot, for example, show in the source 
list only Usernames from specific Servers.  

Tip: You can select a filter type even if the template does not include that data field. For example, you 
can select the Usernames filter even if the eventual report does not contain the Username field. 
Tip: If you don't see a server, organization or username known to exist on your system, a MOVEit 
administrator may have added it recently. Sign out of Ipswitch Analytics and then sign in again.  
Note: The Ipswitch Analytics Server displays as a server option for Administrators and System 
Administrators only. 

5 After you customize the source list to your satisfaction, select individual items to include in the ruleset. 
Remember, this ruleset will allow only these specific MOVEit sources.   

 
Note: Selecting no items is the same as selecting all items in the list. However, if you select one or more 
items in the list, only the items you select will be allowed by the ruleset and any items not explicitly 
selected will be denied.  



 

56 Ipswitch Analytics Installation Guide  

Warning: If you select a different filter (Server, Organization or Username) after selecting items from the 
list, your selections will be lost. 
Note: To include data for a single server that has had two different names in the past, you must select 
both server names in the Filter.  

Use the Search box above the list to locate a specific server, organization or username within the list (the 
asterisk wildcard is accepted). Enter any portion of the name to view all results that contain that string. 
This is useful when there is a large number of items in the list, such as organizations that contain 
hundreds of usernames.  

 
6 After you select all MOVEit source items to include in the ruleset, click Save. 

After you create a ruleset, Administrators and System Administrators can assign it to user groups and to 
schedules. For more information, consult the Ipswitch Analytics Administrator's Guide > Manage > User 
Groups and Schedules. 

Next: Create a User Group (on page 57) 
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Create a User Group 
Create a user group if you want to: 

 Allow only a specific group of users to view and/or manage a Library report 
 Deliver a scheduled report to a specific group of users 
 Limit Creators within a user group to seeing in the Template Editor only those MOVEit sources allowed 

by the ruleset assigned to the user group 

A user does not have to belong to any user group; user group membership is optional.  

A user group includes the following data: 

 User Group Name 
 Description 
 Ruleset (optional). A ruleset blocks Creator users from viewing and selecting specific MOVEit servers, 

organizations and usernames in the Template Editor. 
 User members of the group 

User groups are located in the USERS module under the Groups tab.  

 
Only users with the role of System Administrator or Administrator can create and manage user 
groups. Creators have read-only access to the Groups tab. 

All user groups appear in the left panel, and the users that belong to the selected user group appear in the 
right panel. Ipswitch Analytics comes with only one user group initially: Everyone. The Everyone user 
group contains all Ipswitch Analytics users.  
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If a user group has a ruleset assigned to it, a lock icon appears next to the user group name. Hover your 
mouse over the lock to see the ruleset assigned to that user group.  

 

 To create a user group: 
1 Click the USERS module and then select the Groups tab. 
2 Click Create. The Create User Group page opens. 
3 Provide the following information: 
 Group name 
 Description 
 Ruleset (optional):  Use the dropdown list. You can select one ruleset per group. 

A ruleset blocks Creators from viewing and working with specific MOVEit servers, organizations 
and users in the Templates and Schedule tabs.  
Note: Rulesets that appear in the drop-down list were previously created. For more information, see 
Rulesets. 

4 Click Create. The new group appears in the list of groups, in the left panel. 
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If you assigned a ruleset, a lock icon appears next to the user group name. To see which ruleset is 
assigned to that user group, hover your mouse over the lock icon. 

 
5 Now you can add users to the user group. Click Add User(s)... 

 
6 Click inside the Select Users box to select one or more users from the list that appears.  

Note: Only users who are not already members of the group appear in the list. 

A user group can contain 0 or more users.  
7 Click Save.  

The user is added to the username list on the right. You can now select this user group as a schedule 
recipient, and grant Library report access to this user group. 

 
Note: You can also select a user group and click Delete to remove that group, or click Edit to add or 
remove members from the group. 
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Troubleshooting (Installation) 
Problems and possible causes: 

Cannot access the Ipswitch Analytics server 
 During the Server installation, when selecting a Tomcat certificate option, you imported a Certificate 

Keystore but the keystore failed. To fix the certificate keystore, update the certificate by Modifying the 
Server Installation (on page 63).  

Ipswitch Analytics Server sign-in page does not appear 
 The Ipswitch Analytics Server machine is shut down or is restarting.  
 The Ipswitch Analytics Server service is not running. Check this in your computer's Control Panel 

> Administrative Tools > Services.  
 Verify internet connectivity on both machines. 
 During the Ipswitch Analytics Server installation, the PKCS12 keystore certificate was entered in an 

unsupported format. The installer does not validate imported certificates.  
To fix this: Modify the server installation and select a keystore certificate that has a .PFX or .P12 
extension. 

In the Monitor module, Agent status is Unknown  or Offline  
 The MOVEit database machine is shut down or is restarting.   
 The MOVEit database service has stopped running.  

To check this: On the MOVEit database machine, go to the Control Panel > Administrative 
Tools > Services. Depending on the MOVEit database, make sure either the Microsoft SQL Server or 
the MySQL service is running. 

 The Agent machine is shut down or is restarting.   
 The Ipswitch Analytics Agent service has stopped running on the Agent machine.  

To check this: On the Agent machine, go to the Control Panel > Administrative Tools > Services. 
Verify that the Ipswitch Analytics Agent service is running. 

 There is no Internet connectivity on the Agent machine or the MOVEit database machine. 
 Firewall restrictions prevent the Agent machine from having network access to the MOVEit 

database machine or the Ipswitch Analytics Server machine. 
 The password that the Agent uses to access the MOVEit database has expired or was changed.  

To update the Agent username or password, you must modify the Agent installation (on page 66).  
 The HTTPS port on the Agent machine, the MOVEit database machine and/or the Ipswitch 

Analytics Server machine is not open.  
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To update the port numbers for any of these machines, you must modify the Agent installation (on 
page 66).  

In the Monitor module, the Agent does not appear on the dashboard 
 Modify the Agent installation (on page 66): on the Analytics Server Settings screen, make sure that 

you enter the correct password for the Agent to access the Ipswitch Analytics server.   
 Check the Agent log on the Agent machine, located at C:\Program Files\Ipswitch\Analytics 

Agent\logs\agent.log to see if the Agent is able to receive data from the MOVEit database, 
authenticate with the Ipswitch Analytics Server and send data to the Ipswitch Analytics Server. 
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After you installed Ipswitch Analytics, if you want to make changes to the original setup, you need to 
modify the Ipswitch Analytics Server or an Ipswitch Analytics Agent installation.  

You must modify an Ipswitch Analytics Server installation (on page 63) to change:  

 Tomcat settings:  
 HTTPS Connector Port 
 Ipswitch Analytics Server IP address or hostname (Analytics Server URL) 
 Tomcat Service Logon Account 
 Tomcat SSL certificate option (self-signed or certificate keystore) 
 Certificate passwords, or certificate keystore import 

 Analytics Server Database settings:  
 Admin username and password 
 Access username and password 
 Port 

You must modify an Ipswitch Analytics Agent installation (on page 66) if you want to change: 

 The Ipswitch Analytics Server IP address or hostname and/or port number. 
 The Agent Access Username and/or Password that the Agent uses to gain access to the Ipswitch 

Analytics Server. 
 The Ipswitch Analytics Server public certificate file and/or password. 
 The MOVEit Database Type, Authentication Type, IP address or hostname, Database Name, Port 

number, or login credentials used to access the MOVEit database (this may be required if your corporate 
security policy expires passwords after a set amount of time). 

 The Agent Display Name (the name of the Agent as it appears in Ipswitch Analytics). 

Important: If you upgrade a MOVEit server after installing an Agent on it, you must run the Agent install 
program on that server again and select Modify so that the Agent will detect the proper MOVEit version 
number. If you fail to do so, the older server version number will be reported in Ipswitch Analytics.   
 

Modify 
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Modify the Ipswitch Analytics Server 
You can modify the Ipswitch Analytics Server to update either of the following areas.  

 Tomcat settings:  
 HTTPS Connector Port 
 Ipswitch Analytics Server IP address or hostname (Analytics Server URL) 
 Tomcat Service Logon Account 
 Tomcat SSL certificate option (self-signed or certificate keystore) 
 Certificate passwords, or certificate keystore import 

 Analytics Server Database settings:  
 Admin username and password 
 Access username and password 
 Port 

You do not have to stop your MOVEit DMZ or MOVEit Central server(s) to modify the Ipswitch Analytics 
Server. 

The Modify wizard makes changes in one area at a time. For example, if you select Modify and then select 
Tomcat, you provide changes to the tomcat settings, the program implements them and then closes. If you 
want to also make changes to the database, run the program again, select to modify Database and provide 
your changes.  

Note: You can change the System Administrator's name and password via the USERS module.  

1 Before you modify a Ipswitch Analytics Server setting, stop all Ipswitch Analytics Agents. Go to each 
Agent machine and under Administrative Tools select Services. Right-click Ipswitch Analytics Agent 
and select Stop. 

2 Sign in to the Ipswitch Analytics Server machine using an account with administrator privileges. 
3 Do one of the following: 
 Open Ipswitch_Analytics_Base_vn.exe, where n is the version number of your current software. 
 Open Control Panel > Programs and Features, right-click Ipswitch Analytics Server and 

select Change. 
The installer opens. 

4 Click Next. 
5 Select Modify. Click Next. 
6 Select a category to modify, and click Next. 
7 Modify items in the category you selected:  

Tomcat: 
Tomcat Settings: 
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 HTTPS Connector Port: The connector port used for HTTPS and the Ipswitch Analytics Server URL.  
Adhere to your IT security or other IT network policies when configuring ports.  

 Ipswitch Analytics Server IP address or hostname: Must match the Common Name (CN) in your 
imported keystore certificate. 
IMPORTANT: If you change the Analytics Server IP address or hostname, you must also Modify the 
Ipswitch Analytics Agent (on page 
66, https://docs.ipswitch.com/MOVEit/Analytics1.1/Help/Admin/en/index.htm#28636.htm) so 
that it points to the new name or IP address. 

 
Tomcat Service Logon Account: 
Make a selection based on the account you want to use to sign in and run the Ipswitch Analytics Server 
service: 
 Use Local System Account (default): Uses the Local System account to sign in and run the service. 

This is the account that you used to sign in to Windows. (If you select this option, you are not 
required to provide additional credentials.) 

 Specify a different account: Does not use the Local System account. If you select this option, an 
additional screen opens for you to provide the user name, password, and group of the account to sign 
in and run the Ipswitch Analytics service. To use a domain account, provide credentials in the format 
DOMAIN\username.  

 
Tomcat Certificate: 
Specify how you want the Ipswitch Analytics Server to validate identity certificates:  

 
 Create Self-Signed Certificate  

Select this option for Evaluation Accounts only; it creates a certificate that expires in 90 days. 
Provide a password. Click Next. 

https://docs.ipswitch.com/MOVEit/Analytics1.1/Help/Admin/en/index.htm#28636.htm
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 Import Certificate Keystore: Import an SSL password-protected PKCS12 certificate keystore file 
with .PFX or .P12 file extension. Click Browse to locate and select the certificate keystore, and then 
provide the password for the keystore. Click Next. 

 
Database: 
Specify the Analytics Server Database Settings. This information is required to run the PostgreSQL 
database on the Ipswitch Analytics Server: 

 
 Database Administrator Username: Username for the account that the database administrator can use 

to access the PostgreSQL database if necessary. Recommended: use the suggested username. 
 Database Administrator Password: Password for the Admin Username you specified.   
 Database Access Username: The account that the Ipswitch Analytics Server web application uses to 

access the PostgreSQL database, to insert data that arrives from the Ipswitch Analytics Agents, and 
to retrieve report and monitor data for display. This account is not used by any 
person. Recommended: use the suggested username. 

 Database Access Password: Password for the Access username you specified.  
 Database Port: This port number is predefined to the standard PostgreSQL port. You can specify any 

unused port. 
8 After you finish making the necessary modifications, click Install. 
9 Click Finish. 
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Modify an Ipswitch Analytics Agent 
Note: To change the Agent Access Username or password, change it first in the Ipswitch Analytics interface 
by editing the Ipswitch Analytics Agent user. Then run Modify below to change the Agent Access 
Username on all machines that have Agents that send data to the Ipswitch Analytics Server. 

The machine that hosts the MOVEit database must be online and network accessible before you begin an 
Agent modification. You do not have to stop the MOVEit server to modify an Agent. Agent modification 
will not significantly affect MOVEit DMZ and Central system performance. 

1 If you need to modify the Ipswitch Analytics Server IP address or hostname, first complete the items in 
this step. Otherwise, go to step 2. 
a) Sign in on the Agent machine with administrator privileges.  
b) Go to Administrative Tools and select Services. Right-click Ipswitch Analytics Agent and 

select Stop to stop the Agent service. 
c) Sign in on the Ipswitch Analytics Server machine.  
d) Modify the Ipswitch Analytics Server (on page 63) installation to make the necessary changes to the 

Ipswitch Analytics Server IP address or hostname. 
e) Return to the Agent machine and then proceed with step 3 below, making sure to update the Ipswitch 

Analytics Server IP address or hostname during the Agent modification process. 
2 Sign in on the Agent machine with administrator privileges. 
3 Open Control Panel > Uninstall and select Change. 

The installer opens. 
4 Click Next. 

The Program Maintenance screen appears. Modify is already selected. Click Next. 
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5 Enter the Analytics Server Settings. The Agent forwards data from the MOVEit server to the Ipswitch 
Analytics Server that you specify here. 

 
 Ipswitch Analytics Server IP address or hostname: (From the Tomcat Settings) For example, if you 

entered https://analytics:8443/ura for Ipswitch Analytics Server URL during installation of the 
Ipswitch Analytics Server, enter analytics. 

 Port: The port on which the Ipswitch Analytics Server accepts HTTPS connections. Default is 8443. 
Adhere to your IT security or other IT network policies when configuring ports.  

 Agent Access Username: The username that the Agent uses to authenticate with the Ipswitch 
Analytics server. You specified this username during the Ipswitch Analytics server installation. See 
the Installation Worksheet. 

 Agent Access Password: See the Installation Worksheet. 
Click Next. 

6 If the machine on which you are installing the Agent does not contain an installation of MOVEit Central 
or DMZ, select the MOVEit server type for which you are installing this Agent.   
Click Next. 
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7 Enter the MOVEit Database Settings. 

 
 Database Type: Select either MySQL or Microsoft SQL Server, depending on the type of database used 

by the MOVEit server you selected in the prior step. 
 Authentication Type (SQL Server only): Select the authentication type that is used for logon to the 

SQL Server.  
Windows: SQL Server logon will use Windows authentication. If you select this option, 
username must be entered in the DOMAIN\User format. 
SQL: SQL Server logon uses a separate user/password created specifically for logon to the SQL 
Server database.  

 Database Name: The name of the MOVEit database. If you are installing the Agent on the same 
machine as the MOVEit server, this field is pre-populated.  

 Hostname or IP Address: The location of the MOVEit database. The value you specify depends on 
your configuration: 

• If the MOVEit database is on the same machine as the MOVEit server, value is localhost. 
• If the MOVEit database and MOVEit server are on separate machines, the value is the Hostname 

or IP address of the machine where the database is located.  
Note: If you are installing the Agent on a machine that contains an SQL Server database with 
multiple instances on the same server, the Hostname or IP Address field prepopulates with the 
default value used by MOVEit Central or DMZ (for example, localhost\instance1). You can 
enter a different instance. If the machine does not contain MOVEit DMZ or Central, you must 
enter the instance name manually. 

• If you are installing the Agent on a machine that does not have MOVEit DMZ or Central, the 
default database name appears here (for example, moveitdmz).   

 Port: The port that is used to connect with the MOVEit database.  Default is the default port value 
for MSSQL/MySQL. 
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Note: If the MOVEit database is using a non-standard port number, you must remove the default port 
number and replace it with the non-standard port number.  

 Username and Password: The username and password that allows access to the MOVEit database.  
For an SQL Server database: The Authentication Type you selected in a previous step determines 
what user credentials you enter here. Windows authentication requires that the username be in 
the DOMAIN\User format. 

Tip: If you cannot locate the username and password to the MOVEit database, look 
in C:\MOVEitDMZ_Install.INI file (DMZ) or C:\MOVEitCentral_Install.INI file (Central). 

Click Next. 
8 On the Analytics Agent Settings screen, change the Agent Display Name if necessary. This name 

identifies this MOVEit Central server within Ipswitch Analytics. The name appears in the Monitor 
dashboard and in reports.  

 
Tip: Use the MOVEit Central name in the Agent Display Name so that in the Ipswitch Analytics 
interface, users can identify data that comes from this MOVEit server.   

Important: Agent Display Names must be unique. If an Agent attempts to connect to the Ipswitch 
Analytics Server with a name that is already in use, the connection is denied, the Agent does not appear 
in the Monitor dashboard, and reports do not contain any data from that Agent.  

9 Click Next. 
10 To make changes to the setup, click Back. When you are satisfied with the setup, click Install.  

Warning: If you click Install now, the modification will proceed and you will NOT be able to back out 
your changes even if you click Cancel on the next screen.  

After a few minutes, the modification completes. 
To view the installer log after the installation finishes, select the checkbox. 

11 Click Finish.  
Repeat these steps to modify another licensed Agent for a different MOVEit database. Remove 
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Remove 
This topic describes how to remove the Ipswitch Analytics Server or an Ipswitch Analytics Agent from the 
machines on which they are installed. You might need to remove the Ipswitch Analytics Server or remove 
an Ipswitch Analytics Agent to move them to different machines, for example. 

See: 

Remove the Ipswitch Analytics Server (on page 71) 

Remove an Ipswitch Analytics Agent (on page 74) 
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Remove the Ipswitch Analytics Server 
IMPORTANT: If you plan to remove the Ipswitch Analytics Server and then reinstall it later AND you want to 
retain your existing Ipswitch Analytics Server database, follow the instructions in Remove and Reinstall the 
Ipswitch Analytics Server (on page 73).  

To remove the Ipswitch Analytics Server, first sign in to the Ipswitch Analytics Server machine using an 
account with administrator privileges. 

You can remove the Ipswitch Analytics Server using the Control Panel or the Ipswitch Analytics Server 
installation file: 

Remove the Analytics Server using the Control Panel: 

WARNING: If you remove the Ipswitch Analytics Server via the Control Panel, you will lose your entire 
Ipswitch Analytics Server database.  

1 Open Control Panel > Uninstall a program. 
2 Select Ipswitch Analytics Server from the list and click Uninstall. 

The Ipswitch Analytics Server uninstalls. No further action is required. When the process completes, the 
Ipswitch Analytics Server and its database will be removed from the machine. 

Remove the Analytics Server using the installation file: 
1 Open Ipswitch_Analytics_Base_vn.exe where n is the release number of the Analytics Server.  
2 Cick Next. 
3 Select Remove. 
4 Click Next. 

A screen appears, warning you that if you proceed, your Ipswitch Analytics Server database data will be 
lost.  

WARNING: If you want to keep your Ipswitch Analytics Server database and reinstall Ipswitch Analytics 
Server later, cancel the removal now and follow the instructions here: Remove and Reinstall the 
Ipswitch Analytics Server (on page 73), which shows you how to preserve your Ipswitch Analytics 
Server database for later use. You can also visit the PostgreSQL website 
(http://www.postgresql.org/docs/9.3/static/backup.htm) for instructions on backing up your Ipswitch 
Analytics Server database. 

http://www.postgresql.org/docs/9.3/static/backup.htm
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5 Click Remove. 
6 After several moments, click Finish. 

The Ipswitch Analytics Server and its database are removed. 
7 Verify that c:\Program Files\Ipswitch\Analytics Server is removed. In some cases this folder may remain 

after a removal. Remove it manually if you see the Analytics Server folder remaining.  
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Remove and Reinstall the Ipswitch Analytics Server 
This topic shows you how to save your Ipswitch Analytics Server database, remove the Ipswitch Analytics 
Server, and then reinstall the Ipswitch Analytics Server. 

1 Shut down all Ipswitch Analytics Agents. Go to each Agent machine and under Administrative Tools 
select Services. Right-click Ipswitch Analytics Agent and select Stop. 

2 Sign in on the Ipswitch Analytics Server machine with administrative privileges. 
3 Go to Administrative Tools > Services, right-click Ipswitch Analytics Server and select Stop. 
4 Back up the Ipswitch Analytics Server database by following the PostgreSQL documentation 

(http://www.postgresql.org/docs/9.3/static/backup.htm). 
5 Remove the Ipswitch Analytics Server. See Remove the Ipswitch Analytics Server (on page 71). 
6 Install the Ipswitch Analytics Server. See Install the Ipswitch Analytics Server (on page 21). 
7 Go to Administrative Tools > Services, right-click Ipswitch Analytics Server and select Stop. 
8 Restore the Ipswitch Analytics Server database by following the PostgreSQL documentation 

(http://www.postgresql.org/docs/9.3/static/backup.htm). 
9 Go to Administrative Tools > Services, right-click Ipswitch Analytics Server and select Start. 
10 Go to each Agent machine, and under Administrative Tools select Services. Right-click Ipswitch 

Analytics Agent and select Start. 
 

http://www.postgresql.org/docs/9.3/static/backup.htm
http://www.postgresql.org/docs/9.3/static/backup.htm
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Remove an Ipswitch Analytics Agent 
Removing an Ipswitch Analytics Agent removes all installation files, registry keys, shortcuts, and the 
installation directory that were created during installation.  

After the Agent is removed, the Ipswitch Analytics Server database still contains all data sent from the 
removed Agent, and because of that, the removed Agent continues to appear as an option inside the 
Template Editor's Filter and inside the Rulesets Filter if data exists for that Agent on the Ipswitch Analytics 
Server. 

 To remove an Ipswitch Analytics Agent: 
1 Sign in on the Agent machine using an account with administrator privileges. 
2 Do one of the following: 
 Open Control Panel > Uninstall and select Uninstall. No further action is required. The Agent removal 

is complete. 
 Open the Ipswitch Analytics Agent installation file and complete the steps below. Make sure you 

select the proper installation file. n is the release version number. 

• 64-bit: Ipswitch_Analytics_Agent64_vn.exe  

• 32-bit: Ipswitch_Analytics_Agent32_vn.exe. 
The installer opens. 

3 Click Next. 
4 Select Remove and click Next. 

The Installer is ready to remove the Agent. 

Warning: If you proceed to click Remove, the Agent will uninstall and you will NOT be able to cancel it 
even if you click Cancel on the next screen.  

5 Click Remove.  
6 When the removal is complete, click Finish. 

Note: If you need to reinstall the Agent on this same machine, you must manually remove the following 
folder after removal completes: c:\Program Files\Ipswitch\Analytics Agent. If you cannot remove it, 
terminate any program that may be accessing that directory, such as an antivirus program. If you still 
cannot delete the directory manually, reboot the machine and delete it after reboot.  

If you plan to install an Agent on a different machine that will use the same Agent Display Name as the one 
you just removed, then when installing the Agent select Installing an agent already known to Analytics Server 
on the screen where you enter the Agent Display Name. 
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Update the Analytics server first, then update the Agents. 

Before You Update 

1 Back up your existing database. For instructions, see the POSTgreSQL documentation 
(http://www.postgresql.org/docs/9.3/static/backup.htm). 

Note: Ipswitch strongly recommends that you back up your database before you run the installer.  

2 Back up the following files: 
 cert files. These files are named server*.pem and are located under the install directory 

in apache/tomcat7/certs/ 

 .init file This file is located under the install directory in ...apache/tomcat7/conf/.init 

Note: Make sure that you do not have any files open in the existing installation directories for the 
Ipswitch Analytics Server or the Ipswitch Analytics Agents. 

New License is Required 

A new Ipswitch Analytics license is required to complete the upgrade process. Licenses for your existing 
version of Ipswitch Analytics do not work with the upgraded version. To obtain a new license, visit 
the Ipswitch File Transfer Customer Portal https://ipswitchft.secure.force.com/cp/CPMyLicenses. 

What Happens During the Server Update? 

When you run the installation program, it detects that a previous version of the Ipswitch Analytics server is 
installed. The installation program saves your server settings, retains the database, and uninstalls the 
existing server software. Next, it installs the new version of server software, moves back the database, and 
restores your server settings. You then sign in to the Admin Console and upload your license file. 

First, Update the Analytics Server (on page 76) 

Next, Update the Analytics Agents (on page 77) 
 

Update to a New Release of Ipswitch Analytics 

http://www.postgresql.org/docs/9.3/static/backup.htm
https://ipswitchft.secure.force.com/cp/CPMyLicenses
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Update the Analytics Server 
1 Sign in as Administrator on the Windows machine where the Ipswitch Analytics server is currently 

installed. 
2 Download the Ipswitch Analytics Server installation file: Ipswitch_Analytics_Base_vn.exe, where n is 

the version number of the software.  Open the file. 
The Preparing Setup screen opens, with a progress bar. The installer detects the presence of a previous 
version of Ipswitch Analytics Server software. 
The Welcome screen opens.  

3 Click Next.  
The Setup Status screen opens, showing a progress bar. The upgrade process can take several minutes, 
depending on the size of your database. 

Note: When you originally installed the previous version of Ipswitch Analytics, you provided Tomcat 
Logon Account information. The default was to use the local system account. If during that 
installation you specified a different account, the upgrade program prompts you for the username, 
password, and group of that account. 

4 When the Update Complete screen opens, click Finish. The Ipswitch Analytics sign-in page opens. 
5 Enter your username and password, and click Sign in. Ipswitch Analytics opens to the Licensing page 

with an Upgrade Complete message. 
6 Click Browse to License and select your new license file. The license file is uploaded. 

Next: Update the Analytics Agents (on page 77). 
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Update the Analytics Agent 
Upgrade the Agent on each MOVEit database machine in your Ipswitch Analytics environment.  

1 On the machine where you want to upgrade the Agent, sign in with an account that has administrator 
privileges. 

2 Download the appropriate Ipswitch Analytics Agent installation file, where n is the release number: 
 64-bit: Ipswitch_Analytics_Agent64_vn.exe 
 32-bit: Ipswitch_Analytics_Agent32_vn.exe  

3 Open the Ipswitch Analytics Agent installation file.  
The Preparing to Install screen opens, showing a progress bar. The installation program detects the 
existing agent. A Question dialog box opens with the message "This setup will perform an upgrade of 
'Ipswitch Analytics Agent'. Do you want to continue?"  

4 Click Yes. The Welcome screen appears briefly, and the installation program begins. The process can 
take several minutes. 
In some situations, the following Installer Information message appears: 

The setup must update files or services that cannot be updated while the system is running. If you 
choose to continue, a reboot might be required to complete the setup. 

5 If you receive the information message, click OK. 
The program continues until the InstallShield Wizard Completed screen appears.  

Tip: To open the log after installation finishes, select the checkbox. 
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Administrators can use the updatecert.bat utility to update the truststore whenever the cert has been 
changed on the Ipswitch Analytics server. 

Run the utility in a command promt. 

Description 
The updatecert.bat utility does the following:  

 Downloads a single certificate or a certificate chain from the Ipswitch Analytics server. 
 Recreates the ipswitchcerts file in jre\lib\security directory. 
 Adds the downloaded certs in to the directory. 
 Restarts the Ipswitch Analytics Agent service. 

Location 
The agent installation program places updatecert.bat in the installation directory for the agent. 
Default location is C:\Program  Files\Ipswitch\Analytics Agent\. 

Syntax 
updatecert.bat 

There are no parameters. 

To update the truststore without restarting the service 

Use utilities.bat with option -updatecert. For example: 

utilities.bat -updatecert 

 

 
 

Update a Certificate or Certificate Chain: 
updatecert.bat utility 
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Database Backup 
Back up the server database before you upgrade to a new version of the Analytics Server.  

As a best practice, back up the server database on a regular basis. 

For more information, see the POSTgreSQL documentation 
(http://www.postgresql.org/docs/9.3/static/backup.htm). 

Configuration Files Backup 
Back up the following configuration files after the initial installation of Ipswitch Analytics server, and 
whenever the configuration is modified.  

Important: Store the following files in a secure location. 

 apache-tomcat-7\webapps\ura\WEB-INF\classes\spring\properties\config.properties 
 apache-tomcat-7\webapps\ura\WEB-INF\classes\spring\properties\database.properties 
 apache-tomcat-7\conf\server.xml  
 apache-tomcat-7\conf\.init 
 apache-tomcat-7\certs\*       where * denotes all certs 

 

See also: 

Restore the Analytics Server (on page 80) 
 

Server Backup and Restore 

http://www.postgresql.org/docs/9.3/static/backup.htm
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Restore the Analytics Server 
This procedure assumes that you have previously backed up the database and the configuration files (on 
page 79).  

1 Shut down all Ipswitch Analytics Agents by doing the following on each Agent machine: 
 Under Administrative Tools, select Services. Right-click Ipswitch Analytics Agent and select Stop. 

2 Sign in on the Ipswitch Analytics Server machine with administrative privileges. 
3 Reinstall the Ipswitch Analytics Server. See Install the Analytics Server (on page 21). 
4 Under Administrative Tools, select Services. Right-click the Ipswitch Analytics Server and select Stop. 
5 Restore the Ipswitch Analytics Server database by following the PostgreSQL documentation 

(http://www.postgresql.org/docs/9.3/static/backup.htm). 
6 Copy the following backed-up files from their backup location to the corresponding location under the 

Analytics Server install directory: 
 apache-tomcat-7\webapps\ura\WEB-INF\classes\spring\properties\config.properties 
 apache-tomcat-7\webapps\ura\WEB-INF\classes\spring\properties\database.properties 
 apache-tomcat-7\conf\server.xml  
 apache-tomcat-7\conf\.init 
 apache-tomcat-7\certs\*       where * denotes all certs 

7 Under Administrative Tools, select Services. Right-click Ipswitch Analytics Server and select Start. 
8 Start the Ipswitch Analytics agents by doing the following on each Agent machine: 
 Under Administrative Tools, select Services. Right-click Ipswitch Analytics Agent and select Start.

http://www.postgresql.org/docs/9.3/static/backup.htm
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